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A D VA N C E D  C H A R T I N G
ESIGNAL’S ADVANCED CHARTING offers an extremely flexible user 
interface and includes a full array of line drawing tools, advanced analytics and a for-
mula engine that lets you create your own studies. You can import and create, save 
and even encrypt your own formulas, select from an extensive library of formulas 
and helpers, use advanced scaling features and customize your own Advanced Chart-
ing Favorites Toolbar.

You can choose from the following Advanced Chart types:

l  Daily charts. Daily charts display historical daily data for an issue in graphical 
format.

l Interval charts. Interval charts track an issue’s current and previous intraday 
days’ prices in time intervals that you choose such as 15, 30, or 60 minutes.

Note: You can retrieve up to 60 days of interval data in an Advanced Chart window.

eSignal Advanced Chart Styles
eSignal’s Advanced Charting supports the following chart styles:

1 Bar

2 Line
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3 Candle

4 Point and Figure (PNF)

5 3 Line Break (3LB)

6 Renko

7 Kagi

Each of these chart types is described in the following sections.

Bar (OHLC)
Bar (OHLC). An OHLC Bar Chart displays a series of bars for the interval you 
specify. This bar is comprised of four separate data points: 

– Open: the opening price of the issue at the beginning of the bar interval 

– High: the highest price the issue reached during the bar interval

– Low: the lowest price the issue reached during the bar interval.

– Close: the closing price of the stock at the end of the bar interval.

The Open, High, Low and Close are specific to the time frame covered by each bar. 
An OHLC Bar’s height is derived from its high and low prices during the period it 
covers. As shown in Figure 8.1, the Open is displayed on each bar as a small horizon-
tal tick to the left side of the bar while the Close is shown on each bar as a small hor-
izontal tick to the right side of the bar.

Figure 8-1. A Closer Look at An OHLC Bar
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If an OHLC Bar is green, that means that its closing price was higher than its opening 
price. Conversely, if an OHLC bar is red, its closing price was lower than its opening 
price.

Figure 8-2 shows a 30 minute intraday OHLC Bar Chart for Intel (INTC).

Figure 8-2. OHLC Intraday Bar Chart

Line 
A Line chart plots the closing price for the interval you specify (i.e. 5 minute intra-
day). If you are overlaying multiple symbols on a chart, using a Line chart format 
makes the chart easier to read. 

Figure 8-3 is an example of a Line Chart
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Shortcut: Press the Home key to go to the latest bar in the active Advanced Chart 
window.

Figure 8-3. Line Chart Example

CandleStick
 Like Bar charts, CandleStick charts plot open, high, low, and close data for the chart 
interval you specify. However, Candlestick charts display OHLC data in a more 
visual way which many traders find appealing. 

 The body of a CandleStick is drawn as a rectangle between the opening and the      
closing prices during the interval (i.e. 15 minutes). You will notice that CandleSticks 
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are either red or green in an eSignal Advanced Chart window. Candlestick coloration 
depends on the price activity during the interval the CandleStick represents. The 
wicks at the top and the bottom of each CandleStick represent the high and low 
prices traded during the interval. Figure 8-4 shows a CandleStick chart.

Figure 8-4. Sample Candlestick chart

A Closer Look At Candlesticks
If the open is greater than the close, the Candlestick is colored in red. Conversely, if 
the Open is lower than the close, the CandleStick is green.

Figure 8-5 displays two different types of Candlesticks, a green or Up Candlestick 
and a red or Down Candlestick. 
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Figure 8-5. Sample Up and Down Candlesticks

To change the colors or line styles used for a Candlestick chart:

1 Right click on the Chart and select Edit Studies.

2 The Study Properties dialog box appears as shown in Figure 8-6. Customize your 
color and line choices (thin wick or fat wick).

3 When you are finished making changes, Click “Apply This” and then OK to 
make the changes to the current study while the Properties window is open. Click 
“Apply All” and then OK if you made property changes to several studies and 
want to change them all while the window is still open. Click “Save As Default” 
if you want to have specific settings apply to all future uses of the study. 

Open

Close

High

Low

High

Close

Open

Low

Up Candlestick Down Candlestick
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Figure 8-6. Specifying Price Study Properties
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Point and Figure
Point and Figure charts disregard the passage of time and chart only price changes. 
An "x" is drawn when the price rises by a predefined box size. An "o" is drawn if the 
price falls by a predefined box size. No x's or o’s are drawn if the market moves an 
amount less than the box size.

Figure 8-7. Point and Figure Chart

Figure 8-7 displays a Point and Figure chart that has a box size of 2 and a reversal 
interval of 1 point.
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3 Line Break
A Three-Line Break chart displays new lines if the close of the period moves outside 
of the period of the previous block of trading. If not, then no lines are drawn.

The first line is drawn when the prices are greater, lower, or the same as the opening 
price. If prices exceed the prior high (low) price a new line is drawn If current prices 
are within the prior high or low, no new line is drawn. 

When using a 3 Line Break chart, prices must exceed the prior three high or low lines 
to indicate a reversal.

Figure 8-8. 3 Line Break Chart Type
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Renko
Renko charts display price movements if they are bigger than a fixed amount. For 
example, the following daily Renko chart for CRUS (Cirrus Logic) displays boxes 
representing days where the range from high to low that day was greater than or 
equal to 2 points. 

Figure 8-9. Renko Style Chart
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Kagi 
Kagi charts plot a single line until price reverses by a predetermined amount where 
another line is then begun. It is an attempt to smooth out the noise of daily trading 
activity so that trend can be more clearly represented. The thickness of Kagi lines are 
significant when prior highs and prior lows are exceeded.

The following is an example of a daily Kagi chart that is set up to plot a new line 
when price reverses by more than 1 point.

Figure 8-10. Kagi Chart Style
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Anatomy of an Advanced Chart Window
An Advanced Chart window displays historical data for issues in graphical form. The 
data displayed is determined by the symbol you enter, the chart type and the time 
interval you select

Figure 8-11 identifies the most basic elements of an Advanced Chart window. 

Figure 8-11. Advanced Chart Window Elements
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Favorites Toolbar
What could be simpler than clicking a toolbar button to pull up an Advanced Chart 
window that you access often? eSignal’s Advanced Chart window contains a Favor-
ites Toolbar that lets you access your favorite charts instantly. The Favorites toolbar 
lets you pull up preset charts that you can further customize to meet your needs. 

When you initially open an Advanced Chart, the Favorites toolbar contains certain 
preset folders (Equities and Other Intervals) and shortcuts (1 minute interval chart, 
Daily etc.). You can experiment with the Favorites toolbar shortcuts and pull-down 
menu choices and then customize them to reflect your own needs.

You can customize the Favorites toolbar by adding new shortcut folder names and 
favorites names within the folders, by removing existing favorites shortcuts, chang-
ing the content of existing folders, and even adding new direct toolbar shortcuts.

When you open an Advanced Chart window, the Favorites Toolbar appears at the top 
of the window as shown in Figure 8-12.

Figure 8-12. Advanced Chart Window Favorites Toolbar
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The Favorites toolbar contains several chart shortcut icons. 

 

Click the Link toolbar to link the active Advanced Chart window 
symbol to your Quote window cursor. When the link feature is 
enabled, the Advanced Chart window symbol changes whenever 
you move your cursor to a new symbol.

Opens the Properties dialog box, where you can customize your 
favorite charts and set other chart options.

Click the Add toolbar to add a new custom chart to your Favorites 
toolbar

Enables you to select a favorite equity chart from those you have 
already saved to the Equities folder.

Select Other Intervals from the pull-down list to apply them to the 
active Advanced Chart window.

Select to change to a 1 minute intraday chart for the active 
Advanced Chart window symbol

Select to change to a 5 minute intraday chart for the active 
Advanced Chart window symbol

Select to change to a 60 minute intraday chart for the active 
Advanced Chart window symbol

Select to change to a daily chart for the active Advanced Chart win-
dow symbol
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Building a Favorites List
You can use the Favorites toolbar to create your own favorite list of  “symbols and 
intervals” (e.g. INTC, 5), symbols (INTC) and intervals (e.g. 5) used to quickly 
retrieve the exact charts you need.

To add to your favorites list:

1 Press the   +   in the toolbar. The Add Favorite dialog box appears.

2 In the Use area, select either a Symbol & Interval, Symbol, or Interval 

3 Enter the symbol, interval (D=Daily, 15= 15 minutes, T=Tick etc.), enter a name 
for the favorite, select a folder where you want to save the favorite, and click OK.

4 If you want to create a new folder, click on the Favorites folder and then click the 
New Folder button. Then enter the name of the new folder in the dialog box that 
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appears and click OK to save it. You can also create folders within folders (by 
clicking on the + sign).

5 If you want to add a Favorite shortcut button directly to the Favorites toolbar, 
close the Favorites folder if it is open by clicking the - to its left. Then add a new 
favorite name, symbol and interval and click OK to add it. 

Thereafter, you can access new favorite charts from the Equities, Other Intervals, or 
other pull-down menus you have defined or, directly from a Favorites toolbar icon.

Managing Your Favorites List
To manage your favorites list, click the Properties button on the toolbar to view   
saved favorite charts in the Equities, Other Interval, Favorites and other user-defined 
folders. The My Favorites dialog box appears.
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l Expand the Favorites, Equities, or Other Intervals folders to list currently saved 
favorites in these folders. To remove a favorite, click on it and then click the 
Remove button.

l To add a new favorite chart to the list, click on the + on the Favorites toolbar, 
select the folder you want to save it in, then enter the symbol, interval, and favor-
ite name in the dialog box that appears, and click OK to add the new favorite.

You can also create new favorites folders. To create a new folder, click the + on the 
Favorites toolbar, click on the Favorites folder in the My Favorites dialog box, enter 
a folder name, then click the Add Folder button. Once you have created a new folder, 
select it from the My Favorites dialog box, then enter a new symbol, interval and 
name for each favorite chart that you want to put in the new folder. 

l The Favorites Toolbar supports auto hide. You enable auto hiding by clicking on 
the Properties toolbar button, checking the Auto Hide box, and clicking OK. 
When the auto hide feature is active, the Favorites Toolbar appears when you 
move your mouse cursor where it was resizing, and disappears when the mouse is 
moved off the toolbar.

l The Favorites Toolbar is dockable to other edges of the window (top, bottom, left, 
right). All other eSignal toolbars are dockable too. If a toolbar is docked, you can 
turn on the autohide feature.

l You can conserve screen space on the toolbar by selecting some options under 
properties (separators between top level items, hide images).
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Cursor Window
The Cursor window displays the data for the bar or point you currently have high-
lighted. It is displayed by default when you open an Advanced Chart window. You 
remove the cursor window by de-selecting it from the Advanced Chart Right-click or 
Chart Options menus, or, or clicking on the Cursor Tracking icon on the Advanced 
Charts toolbar.

When you right-click in the main chart area or select the Chart Options menu, the 
following Cursor options appear.

1 Select Cursor Window to toggle the Cursor window on and off.

2 Select Cursor Tracking to toggle cursor tracking on and off.

3 Select Lock in Place to lock the information in the Cursor window so that it does 
not change when you move the Advanced Chart window cross hairs.
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Just right-click on a Cursor Window to access the following menu and customize its 
look and feel.

See the Using the Right-Click Menus section later in this chapter for further detail.

Charting Area
The charting area contains the actual chart. Depending on the chart type and proper-
ties you’ve set, the chart area may include a cursor window, cursor tracking, a vol-
ume histogram, and various technical studies.

Advanced Chart, Line, & Advanced Line 
Toolbars

In addition to the Favorites toolbar that is embedded inside an Advanced Chart win-
dow, there are several other charting-related toolbars that you can use to customize 
your charts: the Advanced Chart Toolbar, the Line Toolbar and the Advanced Line 
Toolbar (See Appendix A for a description of the Advanced Line Toolbar).

You can toggle these three toolbars on and off by selecting/deselecting them from the 
eSignal View menu. In addition, all eSignal Advanced Charting toolbars are dock-
able which means that they can be moved anywhere on your screen. 
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Using the Advanced Chart Toolbar
The Advanced Chart Toolbar is pictured in Figure 8-13 and defined below.

Figure 8-13. Advanced Chart Toolbar

Select to pull up an open, high, low, close bar chart

Select to pull up a Candlestick chart

Select to pull up an OHLC line chart

Select to pull up a Point and Figure chart

Select to pull up a 3 Line Break/3 Point Break chart

Select to pull up a Renko chart

Select to pull up a Kagi chart
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Select to Auto Scale chart data

Select to Scale Price data only

Select to switch to a logarithmic scale

Select to increase bar width

Select to decrease bar width

Select to increase bar spacing

Select to decrease bar spacing

Select to have your Advanced Chart symbol track your cursor

Select so that the Advanced Chart window displays a Cursor win-
dow that shows data for the bar or point your Advanced Chart cursor 
is on.

Select to reset your chart

Select to specify Advanced Chart window properties
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Using the eSignal Line Toolbar
You can use the eSignal Line Toolbar buttons to access tools to draw lines, boxes, 
squares, text and a variety of other studies on an Advanced Bar Chart. Like other 
eSignal Toolbars, the Line Toolbar is dockable and appears by default. You can tog-
gle the Line Toolbar on and off by selecting Line Toolbar in the View menu. 

When you open a new Bar chart, the Line Toolbar appears above the Advanced Chart 
window. Although this is the default location, you can move the Line Toolbar just as 
you can any of the other dockable eSignal toolbars. The Line Toolbar is shown in 
Figure 8-14.

In addition to using the Line Toolbar, you can also access the same line tools in two 
other ways:

1 You can also access line settings from the Tools menu choice that appears in the 
Chart Options menu when an Advanced Chart window is active.

2 By right-clicking on an Advanced Chart window and then selecting Tools

 

Figure 8-14. eSignal Line Toolbar for Advanced Charts 

The following section summarizes the function of each of the Line Toolbar buttons.
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Pointer 

Trend Lines

The Style selection list lets you choose between Segmented, Ray, Extended, Hori-
zontal, Vertical or Arrow lines. Segmented lines are those that have clear starting and 
ending points. A Ray has a starting point, but extends either into the future or into the 
past to infinity. An Extended line is like a Ray except that it has no visible beginning 

The Pointer tool is turned on by default when you open a new bar 
chart. To turn off any other tool from the Drawing Tool Box, just 
press the pointer button with your left mouse button. You can click 
your right mouse button anywhere inside of the bar chart and this 
will also turn the pointer back on.

You use the Lines tool to draw trend lines on a bar chart. To config-
ure the Lines tool, put your cursor on top of the Lines button and 
click your right mouse button. 
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or ending points. It extends into both the future and the past to infinity. An Arrow is 
like a Segmented line but has an arrow on the end of the line. Horizontal and Vertical 
lines are segmented lines that are drawn horizontally or vertically.

To draw a line on a chart:

1 Click on the Trend Lines tool with your left mouse button.

2 Move your cursor into the chart (it should now look like a pencil).

3 Move the cursor to the starting point of your trend line and press your left mouse 
button once. 

4 Move your cursor to the point where you want the trend line to end and press 
your left mouse button again. This anchors your trend line to the bar chart.

To adjust the Style, Color, or Width of a trend line, put your mouse cursor on top of 
the trend line and click your right mouse button. This opens the Trend Lines dialog 
box. When you are finished making your changes, click either OK or Apply to save 
your changes.

To remove a line, right-click on it and click the Remove button.

Click to draw a Line Segment.

Click to draw a Ray

Click to draw an Extended line

Click to draw a Horizontal line
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Regression Trend Channel         

To set Regression Trend Channel properties, click on the Regression Channels tool-
bar button, then click your right mouse button. This opens the Regression Trend 
Channels dialog box.

Click to draw a Vertical line

Click to draw a Regression Trend Channel that is calculated using 
the actual prices of the bars in the trend. A linear regression line is 
calculated and then the upper and lower channels are drawn using a 
standard deviation of the regression line or by using the highest high 
or the lowest low of the trend. The break of a Regression Trend 
Channel is usually used as an entry or exit signal.
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The Trend Line On/Off button indicates whether the Trend Line (regression line) will 
be displayed. The Trend Line does not have to be displayed for the Regression Chan-
nels to work correctly. Press this button to turn the display of the Trend Line On or 
Off.

The Trend Line Source selection list allows you to choose what prices are used to 
calculate the Regression line:

Open Calculates the regression line using the open prices of the bars

High Calculates the regression line using the highs of the bars

Low Calculates the regression line using the lows of the bars

Close Calculates the regression line using the closing prices of the bars.

(H+L)/2 Calculates the regression line using the value derived from the sum 
of the highs and the lows divided by 2.
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The Upper Channel On/Off button indicates if the Upper Channel of the regression 
line will be displayed. Click your left mouse button on this button to turn the display 
of the Upper Channel On or Off. 

The Std. Devs. check box indicates if the standard deviation of the regression line 
should or should not be used for the Upper Channel. When this box is checked, the 
Upper Channel will use the standard deviation indicated in the number box directly 
below it. If the Std. Devs. check box is not checked, the Upper Channel will be 
drawn using the highest and lowest bars in the trend encompassed by the channels.

The Lower Channel On/Off button indicates whether the Lower Channel of the 
regression line will be displayed. Press your left mouse button on this button to turn 
the display of the Lower Channel On or Off. 

The Std. Devs. check box indicates if the standard deviation of the regression line 
should or should not be used for the Lower Channel. When this box is checked, the 
Lower Channel will use the standard deviation indicated in the number box directly 
below it. If the Std. Devs. check box is not checked, the Lower Channel will be 
drawn using the highest and lowest bars in the trend encompassed by the channels.

The End Bar On/Off button indicates that a bar will be drawn below the last bar used 
in the Regression calculation. This is helpful if you are saving the Regression Trend 
Channels and cannot remember which bar you used for the calculation.

The Pearson’s R On/Off button indicates if the Pearson’s R value will be shown at 
the bottom of the Regression Trend Channels. As the Pearson’s R value is closer to 
the value of 1, this means the calculated regression line is matching the actual value 
of the data. This means that the regression line is “fitting” the trend very well. As the 
Pearson’s R value gets closer to the value of  0, the regression line does not match the 
value of the data. This means that the regression line does not “fit” the trend very 

(H+L+C)/
3

Calculates the regression line using the value derived by adding the 
highs, lows, and closing prices and dividing by 3.

(O+H+L+
C)/4

Calculates the regression line using the value derived from adding 
the opens, highs, lows and closing prices and dividing by 4.

H-L Flip The H-L flip indicates that the Automatic Trend Channels should 
be calculated using the Low of the bars when the trend is up, and 
the High of the bars when the trend is down.
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well. Think of this value as a percentage--A 90 percent match is very good, while a 6 
percent match is very bad.

To draw the Regression Trend Channels on a chart, turn on the Regression Trend 
Channels tool by putting your cursor over the Regression Trend Channels button and 
click your left mouse button. When you move your cursor into the chart, you will 
now notice that the cursor looks like three trend lines.

Move the cursor to the starting point where you want the Regression Trend Channels 
to begin and click your left mouse button once. Move your cursor to the last bar you 
want to include in the Regression Trend Channels calculation and click your left 
mouse button again. This anchors the Regression Trend Channels to the bar chart.

If you would like to adjust the Standard Deviation, Color, End Bar, etc., of a Regres-
sion Trend Channel that has already been drawn on the chart, put your mouse cursor 
on top of the Regression Trend Channel and click your right mouse button. This will 
open the Regression Trend Channels dialog box. When you are finished, press either 
the OK or Apply button and the Regression Trend Channels will change to reflect 
any new settings.

To remove the Regression Trend Channels, put your mouse on top of the Regression 
Trend Channels that you want to erase and click your right mouse button. When the 
Regression Trend Channels dialog box appears, press the Remove button. You can 
also erase a Regression Trend Channel using the Eraser tool, which, is covered later 
in this section.

Fibonacci Retracements

Fibonacci Retracements are commonly drawn from the beginning of Wave 1 (the 
Zero point) to the top of Wave 3 to find a target for the Wave 4 retracement.

Use the Fibonacci Retracements tool to measure the amount the 
market has retraced compared to the overall market movement. This 
tool uses ratios which are mathematical in nature, derived from the 
Fibonacci sequence which was developed by Leonardo Fibonacci 
around 1180 ACE. Fibonacci Retracements give you support and 
resistance areas along with general target price areas.
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To configure the Fibonacci Retracements, put your cursor on top of the Fibonacci 
Retracements button and click your right mouse button. This opens the Fibonacci 
Retracements dialog box.

The On/Off toggle button indicates whether or not the corresponding Fibonacci 
Retracement value will be included when you draw the Fibonacci Retracements.

The Value number boxes indicate what Fibonacci ratios are used. If the correspond-
ing On/Off button is toggled On, then that retracement level will be included when 
you draw the Fibonacci Retracements.

The Color selection list allows you to change the color for each Fibonacci ratio.

To remove the Fibonacci Retracements, put your mouse cursor right on top of the 
Fibonacci Retracements that you want to erase and click your right mouse button. 
When the Fibonacci Retracements dialog box appears, press the Remove button.

Fibonacci Extensions

Fibonacci Extensions are most commonly used to find the general area of a Wave 5, 
you would click on the start of Wave 1 (the Zero point), then click on the top of Wave 
3, and click one more time at the end of Wave 4.

To configure the Fibonacci Extensions, put your cursor on top of the Fibonacci 
Extensions button and click your right mouse button. This opens the Fibonacci 
Extensions dialog box.

The On/Off toggle buttons indicate whether or not the corresponding Fibonacci 
Extensions value will be included when you draw the Fibonacci Extensions.

The Fibonacci Extensions tool is used to measure the amount a mar-
ket has extended compared to the overall movement. Fibonacci 
Extensions give you general target price areas.
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The Value number boxes indicate what Fibonacci ratios are to be used. If the corre-
sponding On/Off button is toggled On, then that extension level will be included 
when you draw the Fibonacci Extensions.

To remove the Fibonacci Extensions, put your mouse cursor on top of the Fibonacci 
Extensions that you want to erase and click your right mouse button. When the 
Fibonacci Extensions dialog box appears, press the Remove button.

The Color selection list allows you to change the color for each Fibonacci ratio.

Fibonacci Circles

To configure the Fibonacci Circles, put your cursor on top of the Fibonacci Circles 
button and click your right mouse button. This will open the Fibonacci Circles prop-
erties sheet.

The On/Off toggle buttons indicate whether or not the corresponding Fibonacci Cir-
cles value will be included when you draw Fibonacci Circles.

The Value number boxes indicate what Fibonacci ratios are used. If the correspond-
ing On/Off button is toggled On, that retracement level will be included when you 
draw the Fibonacci Circles.

The Fixed Scale check box and corresponding number box indicate if the Fibonacci 
Circles should be drawn based upon a fixed scale and if so, what scale to use.

To remove the Fibonacci Circles, put your mouse cursor on top of the Fibonacci Cir-
cles that you want to erase and hit your right mouse button. When the Fibonacci Cir-
cles properties sheet appears, press the Remove button.

The Color selection list allows you to change the color for each Fibonacci ratio.

Click to use the Fibonacci Circles tool to project Fibonacci ratios in 
a circular pattern from an origin point that reaches out into time and 
price providing support and resistance areas.
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Fibonacci Time

Fibonacci Time is commonly drawn from Pivot Point to Pivot Point from the same 
side of the market. For example, you would choose a Primary Pivot Point as your 
start for Fibonacci Time, and then pick a second Primary Pivot Point as your ending 
point for Fibonacci Time, with both Pivot Points being on the top of the market.

To configure the Fibonacci Time, put your cursor on top of the Fibonacci Time but-
ton and click your right mouse button. This opens the Fibonacci Time dialog box.

The On/Off toggle buttons indicate whether or not the corresponding Fibonacci Time 
value will be included when you draw the Fibonacci Time

The Value number boxes indicate what Fibonacci ratios are used. If the correspond-
ing On/Off button is toggled ON, that retracement level will be included when you 
draw the Fibonacci Time.

To remove the Fibonacci Time, put your mouse cursor on top of the Fibonacci Time 
you want to erase and hit your right mouse button. When the Fibonacci Time proper-
ties sheet appears, press the Remove button.

The Color selection list allows you to change the color for each Fibonacci ratio.

The Fibonacci Time tool is used to project Fibonacci ratios out into 
time based upon Pivot Points affecting future Pivot Points.
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Text

You can move the note to the area where you want it and press the left mouse button 
to anchor it. Make sure you save the chart before closing it or you will lose your mes-
sage.

To remove the Text of the Thumb Tack, put your mouse cursor on top of the Text or 
Thumb Tack that you want to erase and click your right mouse button. When the Text 
Properties sheet appears, press the Remove button.

Click the Thumb Tack tool to add a small icon that looks like a piece 
of paper with a Thumb Tack to an Advanced Chart window. When 
you have typed your note and pressed the OK button, the text is 
attached to your mouse cursor.
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Zoom

Eraser

Move

Please note that you cannot move the Regression Trend Channels, Fibonacci 
Retracement, Fibonacci Extensions, Fibonacci Time, PTI, Ellipse, or MOB.

The Zoom tool is used to focus on a specific area of a Bar Chart. 
Move the Zoom cursor to the start of the area you want to focus on 
and press your left mouse button. Move the cursor to the right and 
you will notice a light box being drawn on the chart. This is the area 
that will be “Zoomed”. Move your mouse to the end of the area you 
want to focus on and press your left mouse button a second time, 
The chart will reflect the area that you marked. To “Un-Zoom” the 
chart, press the Reset button on the toolbar

You use the Eraser to erase any item that has been drawn on the 
chart by any of the Drawing Tools. To erase a line, move the Eraser 
cursor on top of the line you want to erase and press your left mouse 
button. Please note that once something has been erased off of the 
bar chart, there is no way to "undo" the deletion.

You use the Move Tool to move almost any item that has been 
drawn on the chart by any of the Drawing Tools. To move a line, 
place the Move cursor on top of the line you want to move and press 
your left mouse button. The line will attach to the cursor, and can be 
placed on the chart by pressing your left mouse button.
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Copy

To copy a line, place the Copy cursor on top of the line(s) that you want to copy and 
press your left mouse button. The copy of the line you selected will attach to the 
mouse cursor and can be placed on the chart by pressing your left mouse button.

To configure the Copy Tool, put your cursor on top of the Copy button and click your 
right mouse button to open the Copy Properties dialog box.

The Mode selection list allows you to choose between copying just One Line or All 
Lines on the chart.

Magnet

The Magnet makes it easier to accurately draw lines that touch bar highs or lows. 
You can experiment with different Snap Length values to see what setting works best 
for you. To configure the Magnet, place your cursor on the Magnet toolbar button, 
then click your right mouse button. This opens the Magnet properties sheet 

You use the Copy Tool to copy a line or many lines on the chart. 
This is very useful when you are drawing parallel lines or channels.

You click this tool to add a Price Magnet. A Magnet controls how 
much force is used to pull your cursor to the high or low of a bar 
when drawing any kind of line from the Line Toolbar.
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The Snap Length number box indicates the number of pixels used to determine if the 
Magnet should pull the mouse cursor to the high or the low of the chart. If you set 
this number to 1, then you have to be right next to (1 pixel away from) the high or 
low of the bar before the cursor will be pulled to the high or the low. If you set this 
number to 24, then you only have to be in the general area of the bar for the cursor to 
be pulled to the high or low of the bar. 

Viewing Data in an Advanced Chart Window
You can create a new Advanced Chart window by right-clicking a symbol in a Quote, 
Portfolio, Summary or Leaders window and selecting Advanced Chart, or by choos-
ing New from the File menu. If you already have a Chart window open and don’t 
want to open another one, you can display a new chart in the open Advanced Chart 
window.

To display a new chart in an open Advanced Chart window

1 Make sure the Advanced Chart window is active, then just type a new symbol. A 
Change Symbol dialog box appears as shown below. Type in a new symbol and 
interval, then click OK. The Advanced Chart window you had open changes to 
reflect the new symbol and interval you entered. Available intervals that you can 
enter are D (for Daily), W (for Weekly) and M (for Monthly) and intervals in 
minutes (i.e. 60, 30, 15, etc.)

2 When you initially open an Advanced Chart window, there are preset chart inter-
vals and Favorites lists (lists of preset charts) for Equities and Other Intervals that 
you can choose from the Favorites Toolbar as shown below. 
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3 You can quickly change the interval for data in the Advanced Chart window by 
selecting from the preset intervals of 1, 5, and 60 minutes and Daily from the 
Favorites Toolbar.

To redisplay a Favorite chart in an Advanced Chart window

l Click the down arrow on the Equities list or the Other Intervals list or any other 
user-defined folder list and select the name of a previously saved favorite chart 
from the pull-down list.

Specifying Advanced Chart Window Settings

Right-Click and Chart Options Menus

You have complete access to Advanced Chart Window settings by using either the 
Advanced Chart Window right-click menu and/or the Chart Options menu. The 
Advanced Chart Window right-click menus vary, depending upon where you click 
on the chart.

If you right-click in the data area of the Advanced Chart window, you will see the 
Main Advanced Chart window right-click menu that is discussed in the following 
section.
8-36 e S i g n a l



Chapter 8

ADVANCED CHARTING

.....................................................
Figure 8-15. Advanced Chart Window Main Right-click Menu

Main Advanced Chart Right-Click Menu
Once you have created an Advanced Chart window, you are just a few right-clicks 
away from customizing window properties, changing chart styles, selecting scaling 
methods and cursor options, adding and editing studies, formulas and advanced line 
tools, and un-merging and removing existing studies.

The eSignal Advanced Chart window right-click menu appears in Figure 8-15. 
Please note that you can access the same Advanced Chart window settings menu by 
clicking on the Chart Options menu when an Advanced Chart window is active. The 
only difference between the Advanced Chart window right-click and Chart Options 
e S i g n a l 8-37



Chapter 8

ADVANCED CHARTING

.....................................................
menu is that the right-click menu enables you to select individual studies (See 
Remove Envelope choice above) while the Chart Options menu does not.

Properties
Select Properties to specify chart colors, fonts, margins, and ticker filtering settings.

Figure 8-16. The Chart Properties Dialog Box
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Style Templates
You may want to set up different Style Templates for various types of issues. You can 
do this by saving each of these Advanced Charts as a separate Style Template so that 
you can load it whenever you want. 

Select Style Templates to load a particular style template, to save a chart as a style 
template, to set a particular chart as your style template, or to load the default chart 
style template. The default eSignal style template is called Default.ach. However, 
you can make any existing advanced chart a style template and once you save it as 
the Default, it will then be available. 

Figure 8-17. Style Template Submenu
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Time Templates
Select Time Templates to load a particular time template or to load one of the default 
chart time templates that comes with eSignal (sample default Time Templates are 
shown in the right-click menu in Figure 8-18).

Figure 8-18. Time Templates Right-Click Menu

Template files all have the suffix of.ach (i.e. Advancedchart.ach) and are stored 
under the eSignal program directory. The Style and Time Templates submenus can 
also display up to 4 of the most recently saved or loaded templates for easy access. 

To Edit A Time Template:

1 Right-click on the main data area of an Advanced Chart window.

2 Select Time Templates, then Edit from the right-click menu.
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Figure 8-19. Time Templates Dialog Box

3 The Time Templates dialog box appears. It lists all default templates and any oth-
ers that you have saved. The Time Template that is currently being used by the 
active chart is highlighted and its Template items are listed in the Template Items 
section of the dialog box 
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4 You may change the Default Type, Interval, number of days or start and end 
times. 

5 When you are finished updating the selected Time Template, click the Update/
Add button.

6 You can also use the Time Templates dialog box to create a new template (click 
the New Template button), delete an existing template (click the Delete Template 
button), rename a template (click the Rename Template button), or copy an exist-
ing template (click the Copy Template button).

7 When you are finished managing your Time Templates, click the Close button to 
close the Time Templates dialog box. 

Title Bar
Select Title Bar from the Advanced Chart right-click menu to toggle the Advanced 
Chart window title bar on and off.

Chart Types-Description & Interpretation

Bar 
 Select Bar from the Chart Type right-click submenu to change the active Advanced 
Chart window to an OHLC (Open, High, Low, Close) Bar chart.

Candle
Select Candle from the Chart Type submenu to change the active Advanced Chart 
window to an Candlestick chart.

Line
Select Line from the Chart Types submenu to change the active Advanced Chart win-
dow to a Line chart that connects the closing prices (by default) for each chart inter-
val. You can also base the Line chart on a variety of price sources such as open, high, 
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low, close, or combinations of these sources. When a line chart is active, right click 
and select Edit Studies to select from several Sources on which you can base the line. 

Point and Figure
Select Point and Figure from the Chart Types submenu to change the active 
Advanced Chart window to a Point and Figure chart. Point and Figure charts disre-
gard the passage of time and chart only price changes. An "x" is drawn when the 
price rises by a predefined box size. An "o" is drawn if the price falls by a predefined 
box size. No x's or o’s are drawn if the market moves an amount less than the box 
size.

3 Line Break (a.k.a 3 Point Break)
Three Point Break charts originate from Japan and were introduced to the western 
world by Steve Nison (author of Beyond Candlesticks). They are called Three Line 
Break charts because they usually use three line blocks to calculate reversals.

A green block is drawn in a new column on the chart if the closing price exceeds the 
previous high price. Conversely, a new red block is drawn if the close makes a new 
low. If there is neither a new high or low, nothing is drawn.

With a default Three Line Break, if a rally is powerful enough to form three consecu-
tive green blocks, then the low of the last three green blocks must be exceeded before 
a red block is drawn. If a sell-off is powerful enough to form three consecutive red 
blocks, then the high of the last three red blocks must be exceeded before a green 
block is drawn.

To draw line break blocks, today's close is compared to the high and low of the previ-
ous block. A block is drawn only when today's close exceeds the high or low of the 
previous block. If today's close is higher than the top of the previous block, a new 
green block is drawn in the next column from the prior high to the new high price. If 
today's close is lower than the bottom of the previous block, a new red block is drawn 
in the next column from the prior low to the new low price. If the close fails to move 
outside the range of the previous block’s high or low, then nothing is drawn.

With the default Three Line Break chart, a downside reversal (i.e., green blocks 
change to red blocks) occurs when the price moves under the lowest price of the last 
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three consecutive green blocks. A red reversal block is drawn from the bottom of the 
highest green block to the new price. An upside reversal (i.e., red blocks change to 
green blocks) occurs when the price moves above the highest price of the last three 
consecutive red blocks. A green reversal block is drawn from the top of the lowest 
red block to the new high price.

Indicators calculated on Three Line Break charts use all the data in each column and 
then display the average value of the indicator for that column.

Interpretation/Trading Signals

1 Buy when a green block emerges after three prior red blocks and sell when a red 
block appears after three green blocks.

Renko
The Renko charting method is thought to have acquired its name from "renga" which 
is the Japanese word for bricks. Renko charts were introduced by Steve Nison (for 
more information on Renko charts, you may want to read his book Beyond Candle-
sticks).

Renko charts are similar to Three Line Break charts except that in a Renko chart, a 
line (or brick as they are sometimes called) is drawn in the direction of the prior 
move only if a fixed amount (i.e. the box size) has been exceeded. The bricks are 
always equal in size. For example, in a five unit Renko chart, a 20 point rally is dis-
played as four equally sized, five unit high Renko bricks.

To draw Renko bricks, today's close is compared with the high and low of the previ-
ous brick (green or red). When the closing price is greater than the previous brick by 
the box size or more, one or more equal height, green bricks are drawn in the next 
column. If the closing price falls below the bottom of the previous brick by the box 
size or more, one or more equal height, red bricks are drawn in the next column. 

If the market moves up more than the amount required to draw one brick, but less 
than the amount required to draw two bricks, only one brick is drawn. For example, 
in a two unit Renko chart, if the base price is 100 and the market moves to 103, then 
one green brick is drawn from the base price of 100 to 102. The rest of the move -- 
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from 102 to 103 -- is not shown on the Renko chart. The same rule applies whenever 
the price does not fall on a box size divisor.

Indicators calculated on Renko charts use all the data in each column and then dis-
play the average value of the indicator for that column.

Interpretation

Basic trend reversals are signaled with the emergence of a green or red brick. A new 
green brick indicates the beginning of a new uptrend. A new red brick indicates the 
beginning of a new downtrend. Since the Renko chart is a trend following technique, 
there will be times when the market induces whipsaws. However, a trend following 
technique is intended to allow traders to ride on the major portion of the trend.

Since a Renko chart isolates the underlying trends by filtering out minor ups and 
downs, they are excellent for helping determine support and resistance levels.

Kagi
Kagi charts plot a single line until price reverses by a predetermined amount where 
another line is then begun. It is an attempt to smooth out the noise of daily trading 
activity so that trends can be more clearly represented. The thickness of Kagi lines 
are significant when prior highs and prior lows are exceeded.

Cursor
The Cursor menu enables you to specify the following Advanced Chart Cursor win-
dow settings:

Cursor Window
Select Cursor Window to display information about various data points in a summary 
window. When the Cursor Window is active, the data it displays for bars and studies 
updates as you move the cross hairs along the chart. If you hold down the CTRL key 
while moving the cross hairs, only the X cross hair value updates in the Cursor Win-
dow. Hold down shift and only the Y hair updates.
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Cursor Tracking
Select Cursor Tracking to toggle the Advanced Chart window cross hairs on and off. 

Lock in Place
Select Lock in Place if you want the information currently displayed in the cursor to 
remain or be locked in place even when you move the chart cross hairs.

Scaling

Auto Scale
Select AutoScale from the Advanced Chart right-click menu to automatically scale 
the active Advanced Chart window. Autoscaling adjusts the Y-Axis to fit the chart’s 
high and low prices. If this feature is disabled, you would have to scroll up and down 
vertically while scrolling backwards to adjust the scaling.
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Scale Price Data Only
Select Scale Price Data Only from the Advanced Chart right-click menu to scale only 
the price data in the active Advanced Chart window. This eliminates applying any 
price studies to the scaling and makes it easier to read the price chart.

Log Scale
Select Log Scale from the Advanced Chart right-click menu to apply a logorhythmic-
scale to the active Chart window. A log scale is often used to pinpoint small price 
changes in a high priced stock.

Cursor Window Right-Click Menu
When you right-click the Cursor window, you will see a menu similar to the one 
shown below:
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1 Select Properties to pull up the Cursor Window Properties dialog box.

2 Specify your Cursor Window property preferences by selecting/de-selecting 
from the various options shown.You may also change the Cursor Window font. 

3 Select OK to apply your changes to the Cursor Window.

4 The Cursor Window right-click menu also displays other data relating to the 
Price (Symbol, Interval), Volume and lists any other studies that have been added 
to the Advanced Chart. If you wish to remove any of this additional data from the 
Cursor Window to conserve space, simply click on the check mark next to each 
item in the right-click menu.
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Tools
The Tools Submenu shown in Figure 8-20 provides access to all tools that are avail-
able in the Line and the Advanced Line Toolbars. Since these Toolbars have already 
been discussed, we won’t talk any more about them here. Instead, just go to the refer-
ence pages next to each study name to get further detail on that particular tool.

Figure 8-20. The Tools Submenu
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In addition to providing access to all Line and Advanced Line tools, the Tools right-
click menu also displays a few additional choices that we’ll discuss below.

Magnet see page 8-34

View Use to toggle off/on Lines, 
Gann Lines, or Fibonacci 
Lines

Delete for All Symbols Enables you to delete Lines, 
Gann Lines, Fibonacci Lines, 
Trend Lines, Text, and All for 
all symbols

Delete for Current Symbol Use to delete Lines, Gann 
Lines, Fibonacci Lines, Trend 
Lines, Text and All for the 
current symbol

Delete All Text Select to delete all text asso-
ciated with the active chart

Restore All Text Select to restore all deleted 
text to the active chart

Pointer see page 8-23

Trend Lines see page 8-24

Regression Trend Channels see page 8-25

Fibonacci Retracement see page 8-28 

Fibonacci Extensions see page 8-29

Fibonacci Time see page 8-31

Fibonacci Circles see page 8-30

Gann Angles see page   21-90

Gann Box see page   21-91

TJ’s Ellipse see page   21-92

Andrew’s Pitchfork see page   21-93

Profit Taking Index see page   21-94

Time & Price Squares see page   21-94
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Un-Merge Studies
Select Un-Merge Studies to un-merge any studies you have previously merged on the 
active Advanced Chart window.

Edit Studies
Select Edit Studies to edit a study that is currently applied to the active Advanced 
Chart window. Select a study that you want to edit from the pull-down study box, to 
edit settings, colors and other display options. When you have finished editing a 
study, click OK to apply your changes for that study to the Active Advanced Chart 
window. Since you have a pull-down of all studies, you can make changes to more 
than one study. “Apply This” applies the changes for the study and chart you are cur-
rently editing. “Apply All” applies the changes for all of the edits if you made 
changes to more than one study. 

Add Study
eSignal’s Advanced Charting supports many basic studies that you can apply to your 
charts. Select Add Study to choose from a selection of over 20 technical studies that 
you can add to an Advanced Chart window. 

 Price only studies such as Bollinger Bands appear above the line in the right-click 
menu. You can apply multiple studies to Advanced Charts and even merge studies. 
Please refer to Appendix A for a complete description of over 20 eSignal Advanced 
Charting studies and details on how they are used.

Make or Break see page 21-97 

Text see page   8-32

Zoom see page   8-33

Eraser see page   8-33
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Figure 8-21. Advanced Charting Add Study Sub-Menu
8-52 e S i g n a l



Chapter 8

ADVANCED CHARTING

.....................................................
Add Advanced
eSignal now offers Advanced Technical Studies from Advanced GET, a leading tech-
nical analysis software package as an add-on service. You can add Advanced GET 
studies to a Chart window by right-clicking on an Advanced Chart window and 
selecting Add Advanced, then the specific tool you want to add from the sub-menu. 
Each of the Advanced GET technical studies is defined in detail in Appendix A. 

Figure 8-22. Advanced GET Study Menu/Sub-Menu
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Add Formulas
Select Add Formulas to add an eSignal Advanced Charting formula to the active 
Advanced Chart window.

Remove All Studies
Select Remove All Studies from the right-click menu to remove all studies that have 
previously been applied to the Active Chart window.

Remove Specific Study
In addition to being able to remove all studies from the right click menu, you can also 
remove individual studies. Just right-click on the study you want to remove. Remove 
(name of study you selected) appears at the bottom of the Advanced Chart right-click 
menu. Select Remove (name of study) to remove the study from the chart.

Y-Axis Right-click Menu
By default, the Advanced Chart Y-Axis displays the current issue price (color-coded 
green for up from the last bar or data point price or red if below the previous bar or 
data point’s close), the value of any studies calculated up to the present time, and the 
volume for the latest bar or data point displayed on the Advanced Chart. 

 

If you do not want to see the above information on the Y-Axis, just click on the 
check mark to its left to remove the data.
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Advanced Chart - Click and Drag Features

Scrolling
You can place your mouse on the X-Axis of an Advanced Chart and move pull or 
move it to the right to scroll back in time. Conversely, move your mouse to the left to 
scroll ahead in time.

Rescaling
To reset scaling, click the Reset Toolbar button on the Advanced Chart Toolbar.

Resizing
To resize the Y-Axis, click on it and drag it up or down.

Repositioning Studies
You can reposition studies by holding down the Control key, grabbing a study and 
dragging it to your desired location.

Merging Studies (non-price)
You can merge non-price studies in an Advanced Chart window. To merge studies, 
click on the first study, hold down the Shift button, and drag the study over the study 
you want to merge it with. Please note that you cannot merge price studies. To 
unmerge a study, right click on the section of the chart where the studies are merged, 
then select Un-Merge studies from the right-click menu. 
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Adding Formulas
eSignal’s Advanced Charting supports an extensive library of analytical formulas. 
Select Add Formulas form the eSignal Advanced Chart right-click menu to access a 
listing of available formulas.

Figure 8-23. Adding Formulas to Advanced Charts
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Accessing Formula Folders
When you right click in an Advanced Chart Window and select Add Formula from 
the menu, you will see six or more different formula folders. The following is an 
example of a formula folder and an image of the folder expanded so you can view the 
list of formulas it contains. All formula files have a.efs extension and are stored in 
the eSignal directory. You will want to go to Appendix A - Advanced Charting For-
mulas and Studies for further detail on these formulas.

Helper Folder

Figure 8-24. The eSignal Helper Formula Folder and Formula Files
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The Formulas Menu
You can use eSignal’s Formulas menu to set global properties for the formula engine, 
to turn the Formula Output window on or off, to access the formula editor, and to 
encrypt and decrypt formulas.

Figure 8-25. The eSignal Formula Menu

Editor
eSignal includes a Formula Editor that you can use to modify any of the over 50 pre-
set formulas that come with eSignal. Since all eSignal formulas are written in Java 
script, they are simple to modify once you have a basic knowledge of the language. 
To learn more about the formulas eSignal includes, and the basics of using and mod-
ifying formulas, make sure you read Appendix A - eSignal Formulas and Studies. 

The Formula Editor Toolbar
When you open a formula, it is displayed in a Formula Editor window. All of the for-
mula components are color coded so that you can identify them more easily.

You can view the formula in this window, make your changes, check a formula’s 
syntax to make sure there are not any errors, change Formula Editor properties and 
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use the Formula Editor toolbar to help you work with a formula. The Formula Editor 
toolbar appears below along with a description of each toolbar button’s function.

Figure 8-26. eSignal Formula Editor Toolbar

Clears the Formula Editor window so that you can write a new for-
mula

Opens the formula folder from which you choose a formula to open

Saves a formula under its existing name

Saves a formula as a different name

Cuts selected text from the Formula Editor window

Copies selected text to the clipboard from the Formula Editor win-
dow

Pastes clipboard text into the Formula Editor window
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Undoes the last change

Redoes the last change

Finds a character, word or phrase

Finds the next occurrence of a character, word, or phrase

Find and replace

Print

Properties

Syntax Check

Protected formula
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Formula Editor Properties
The various components of the formula (i.e. variables, reserved words, etc.) dis-
played in the Formula Editor window are color coded so that you can identify what 
they are more easily. If you want to see what default color is displayed for various 
formula components in the Formula Editor window, click on the Properties toolbar 
button in the Formula Editor Window. The formula Editor Properties dialog box 
appears.

Figure 8-27. Formula Editor Properties Dialog Box
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To specify Formula Editor Properties:

1 Select various formula components in the Colors section to change the color in 
which they are displayed in the Formula Editor window

2 Click the Font button to modify the font used to display a formula in the Formula 
Editor window.

3 Select Auto Indent to automatically indent new lines in the Formula Editor win-
dow.

4 Select Show Caret line to highlight the line your cursor is on in yellow (the 
default color).

5 Select Auto Complete and the formula editor will pop up a window as you are 
typing keywords in the editor. For instance, if you type "get", auto complete will 
open a window showing all of the possible functions that start with "get". You 
can then choose from among these functions to help you write your formula.

6 Select Call Tips to get function tips as you type them into the Formula Editor 
window. For example, if you type "Math." when you type the "." you will get a 
popup menu that lists all of the functions that are part of the math class. 

7 Select View End of Line Marker to mark the end of a line to make it easier to see.

8 Select View White Space Markers to display markers that identify white spaces 
in your formula.

Syntax Checking and Error Reporting
If there is a syntax error in a formula, it is displayed in the eSignal formula output 
window and is also saved to a file called formulaoutput.log that resides in the eSignal 
folder. The Formula Output window can be turned on or off via the View menu. 

A helpful feature of the formula output window is a little arrow that appears in the 
title bar of the window. When the arrow is pointing up, the window is always visible. 
When the arrow is pointing to the left, the window will auto contract/expand. When 
the mouse is on top of the window, it expands and stays expanded. When the mouse 
is not over the window, after a small delay, the window will auto contract. 
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Encrypting/Decrypting Formulas
You can use eSignal to encrypt and decrypt proprietary formulas. This feature is 
available as an add-on service. You can create your own formulas and then encrypt 
them and/or import other encrypted formulas into eSignal.

When you encrypt a formula, you provide eSignal with a password and an e-mail 
address. Then, if you forget your formula, just send your user name and e-mail 
address to eSignal and eSignal will e-mail you your password. Since eSignal e-mails 
your forgotten password to the e-mail address that you provided when you encrypted 
your formula, it is important that you provide a valid e-mail address and keep eSignal 
updated on it if you wish to receive your password.

When you encrypt a file (e.g. newformula.efs) a backup file is made and named new-
formula.sav. If newformula.sav already exists, newformula1.sav (and so on) will be 
created. Once a formula is encrypted, eSignal also offers you the ability to decrypt it.

To encrypt a formula:

1 Select Encrypt/Decrypt from the Formulas menu.

2 Select the formula that you want to encrypt from one of the formulas folders that 
appears in the Formula Encryption/Decryption dialog box.
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3 The Formula Encryption Password dialog box appears as shown below.
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4 Enter your password, reenter it to verify it, enter your e-mail address, then click 
OK.

After you have encrypted a formula, a “lock” icon appears next to the formula name 
when you display it on an Advanced Chart.

To Decrypt an Encrypted File:

1 Select Encrypt/Decrypt from the Formulas menu.

2 Select the formula that you want to decrypt from one of the formulas folders that 
appears in the Formula Encryption/Decryption dialog box.

3 Click the Decrypt button, then close the dialog box when the decryption is com-
plete.

The Formula Output Menu
You can use the Formula Output Window to view formula output to see if there are 
any syntax errors in a new formula you have written or modified. The Formula Out-
put window is on by default. You can toggle the Formula Output menu on and off 
from the View menu by selecting/deselecting Formula Output Menu.

To turn the Formula Output window on, select Formula Output from the Formulas 
menu. Then, to perform a syntax check on a formula you have open in the Formula 
Editor Window, click the check mark on the Formula Editor Window toolbar. eSignal 
performs the syntax check and displays “No Syntax Errors” in the Formula output 
Window if the formula checks out. Or, eSignal will display the syntax error(s) in the 
Formula Editor Window if there are any. So, you can quickly review any syntax 
errors, fix them, and then retest your formula in a couple of quick steps. 
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Specifying Formula Settings

Select Settings from the Formulas menu to open the Formula Engine Settings dialog 
box where you can specify heap and stack size, the Formula Root Directory and the 
Formula Output Root directory. Click OK to save your changes and close the dialog 
box.
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